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SonicWALL Global VPN Client 2.1 
 
 

Overview 
This FAQ will cover questions and answers regarding SonicWALL’s Global VPN Client version 2.1. This document 
will be updated frequently, and new versions will be released when any information is changed, updated, or 
removed. The revision number of this FAQ can be found at the end of this document. If you have questions not 
covered in this document, please email them to ‘dparry@sonicwall.com’, and they will be covered in a revised 
version. 
 
 
Global VPN Client (GVC) Q&A Section 
 
What is it? 
The SonicWALL Global VPN Client software provides mobile users with secure, reliable access to corporate 
resources through broadband, wireless and dial-up connections. Just enter in a domain name or IP address. The 
VPN configuration information is automatically downloaded from the SonicWALL VPN gateway and the connection 
is enabled. Custom-developed by SonicWALL, the Global VPN Client has been specifically engineered to take 
advantage of the features and benefits of SonicWALL's third-generation and higher Internet security appliances, 
adding greater value to SonicWALL's remote access solutions. The Global VPN Client uses innovative SonicWALL 
technology to deliver tighter integration for greater ease of use and manageability. SonicWALL's Global VPN Client 
provides cost-effective, secure access for mobile users from any location, using any Internet connection, over any 
IP network environment. 
 
How much does the standalone version of GVC cost? 
When you purchase GVC licenses, you get one year of software subscription support, so you’ll be able to download 
new versions and patch versions for one year after the licenses are installed and activated. When the year is up, 
you can purchase ongoing yearly software subscription support licenses for your GVC licenses to maintain the 
ability to get new versions and patch versions.  
 
� Global VPN Client 1 User License  $50 
� Global VPN Client 5 User License  $215 
� Global VPN Client 10 User License  $345 
� Global VPN Client 50 User License  $595 
� Global VPN Client 100 User License  $795 

 
What operating systems can the GVC be installed on? 
The GVC can be installed on Windows 98 SE, Windows ME, Windows NT 4.0 Professional SP6, Windows 2000 
Professional SP3, Windows XP Professional, and XP Home Edition operating systems. It is not supported on any of 
Microsoft’s Server operating systems. Please note that while the standalone GVC is supported on Windows 98SE 
and Windows ME systems, the GSC components are not. 
 
What firmware versions does the GVC work with? 
In order to accept incoming connections from the GVC, the SonicWALL device must run Firmware 6.4.2 and up, or 
SonicOS 1.x and up. Older models that are incapable of running Firmware 6.4.2, such as the older GEN1 devices, 
cannot accept incoming connections from the GVC. 
 
What’s the difference between GVC and “GVC Enterprise”? 
GVC Enterprise is a merely different SKU and can be license-shared across multiple SonicWALL devices by 
creating a license-sharing group and having one or more SonicWALL devices participate in the group. It is not a 
separate version of GVC. At present, GVC license-sharing groups can only be created on SonicWALL PRO 4060 
devices. 
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How does the GVC work? 
SonicWALL designed the GVC with two goals – one, to make it extraordinarily easy to use for administrator and 
enduser alike, and two, to still maintain an extremely high level of security for the end-to-end connection. Once you 
use the GVC, you will quickly see that these goals have been achieved. Installation and configuration have been 
streamlined so that the enduser only need know the IP address or FQDN of the SonicWALL, and their username & 
password, in order to successfully connect. There’s no need to enter in a bunch of often complex and confusing 
encryption and network details into the client -- upon successful authentication, the SonicWALL sends all the 
security and network topology information to the GVC in real-time. Any changes made to the SonicWALL will force 
an immediate update for all connected GVC clients, or they can be retrieved the next time the GVC connects to the 
SonicWALL device. 
 
What happened to SonicWALL’s older VPN client? 
SonicWALL devices still fully support incoming connections from the older VPN client (which was based on 
versions 5.x and 8.x of SafeNet’s IRE VPN Client), and will continue to do so for some time. The SonicWALL 
Global VPN Client was developed in-house and is designed to be much easier to install, deploy, use, and manage. 
Please note that SonicWALL no longer resells the older VPN client; if you are currently using an older version, it is 
suggested that you upgrade to the new client eventually. 
 
Does GVC support XAUTH? 
Yes, it does, and as of version 2.1 it also supports the ability to pass along notifications to users that their password 
is about to expire, and that he/she should use CTRL+ALT+DELETE to change it. 
 
Can users store their usernames and passwords in GVC? 
Yes, but only if the security policy on the SonicWALL device allows this. By default, the GroupVPN connector will 
allow the GVC to cache the username and password on a session basis, meaning that the GVC will be able to use 
it each time the SA lifetime expires and renegotiates for phase one and phase two. This option prevents the user 
from being continually prompted for username and password info each time the SA lifetime expires. The 
administrator has the option to force reauthentication, and has the option to let the user permanently store the 
username and password on the GVC. The GVC will allow the user to store the username and password only after 
it’s successfully performed one connection and disconnection to/from the SonicWALL device. SonicWALL does not 
recommend allowing users to store usernames and passwords in the GVC, since if the system is compromised it 
will be able to connect to the SonicWALL device without being prompted for authentication. 
 
Does the GVC integrate with analog dial-up modem connections? 
Yes, as of version 2.0, connection profiles in the GVC to an ISP dial-up profile on the system it’s installed on, 
eliminating the need to first launch the dial-up connection and then the GVC client. This allows for one-click access 
to the ISP POP and for VPN access. The GVC has support for Microsoft dial-up profiles and can additionally be 
integrated with third-party dialers, such as AT&T’s dialer client. 
 
Can I use digital certificates with the GVC? 
Yes, all versions of the GVC have the ability to use digital certificates for authentication, instead of using a 
preshared key or the default Simple Key. The GVC includes a certificate management tool that allows the admin or 
user to import pre-created keys and certs into the GVC for use when connecting to a SonicWALL device that’s 
been set to use digital certificates as the authentication mechanism.  
 
Speaking of that . . . what exactly is the “Simple Key”? 
This is an ease-of-use feature that eliminates the need for users to enter a common preshared key as the phase 
one authentication mechanism – the SonicWALL firmware and the GVC have a predefined key burned into the 
software that is used to negotiate phase one automatically. Please note that this predefined key cannot be read, 
exposed, changed, or deleted from the GVC or the firmware. It’s strongly recommended that if you are using this 
feature that you use XAUTH for real-time authentication of all incoming clients. If your environment requires 
additional levels of security, you can always disable the Simple Key feature and instead use a configurable 
preshared key, or digital certificates, as the phase one authentication mechanism. 
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Can I define a backup gateway in the GVC for a connection profile? 
Yes, you can add up to five backup gateways. Version 2.1 of the GVC has the ability to automatically add backup 
gateways when a FQDN resolves to more than a single IP address (it will set the first one it finds as the primary 
and any subsequent ones in order as the backup gateways). 
 
How does the GVC determine that a primary gateway is unavailable? 
If the primary gateway does not respond within 15 seconds when first activating the connection, the GVC will move 
to the next backup gateway configured on the list for that connection. When an active connection’s gateway stops 
responding and/or passing traffic successfully, the GVC will use the Dead Peer Detection timers (default is to check 
every 5 seconds, and to fail to backup after 3 failed checks) to make the determination whether or not the gateway 
is still valid. 
 
Can I install GVC on a system that already has a third-party VPN Client installed? 
No. Since most third-party VPN clients now utilize virtual adapters (including the GVC), a conflict will occur if you 
install more than one VPN client on a system (such as Cisco’s Unity VPN Client, or Check Point’s SecuRemote 
Client).  
 
Can I install it on a system with a previous version of GVC already installed? 
No, you must uninstall the existing installed GVC before installing a new one. Please note that connection entries 
and all previously entered digital certificates can be retained when the GVC is uninstalled, so when a new version is 
installed, this information will not have to be re-entered. 
 
I can’t connect to my SonicWALL with GVC – any ideas? 
The first place to start with any connection problem is the GVC’s log. This can be accessed by going to the ‘View > 
Log Viewer’ menu in the GVC, or by pressing CTRL-L when the GVC is open and is at the forefront of all screens. If 
you’re using version 1.x of the GVC, please note it does not support AES encryption – the GroupVPN policy of the 
SonicWALL device you’re attempting to connect to may be configured for AES. If it’s necessary to terminate 
incoming GVC connections from 1.x and 2.x clients, you will need to use 3DES as the encryption mechanisms for 
phase one and phase two. Another thing to check and see if GSC enforcement is enabled in the GroupVPN policy 
of the SonicWALL device you’re attempting to connect to – if you are running standalone GVC and this option is 
enabled, you will not be able to connect. 
 
I noticed some SonicWALLs are bundled with GVC licenses – how does that work? 
� IPSec VPN Upgrade: 1 license 
� SOHO TZW:  licensed for all WLAN-side connections 
� TZ 170 25-Node: 1 license 
� TZ 170 U-Node:  1 license 
� PRO 2040:  10 licenses 
� PRO 3060:  25 licenses 
� PRO 4060:  1000 licenses 

The following SonicWALL products do NOT include a VPN Client license: TELE3, TELE3 TZ, TELE3 TZX, TELE3 
SP, SOHO3 10-node, SOHO3 25-node, SOHO3 50-node and TZ 170 10-node. 
 
How does GVC licensing work? 
SonicWALL Global VPN Client is licensed on a per connection basis. That means a 5 pack of Global Security Client 
gives the customer 5 concurrent Global VPN Client connections on the SonicWALL. 
 
Does the GVC support split-tunneling? 
Yes, but it’s dependent upon the GroupVPN policy of the SonicWALL you’re connecting to – it’s possible to block 
incoming GVC users from doing split-tunneling and force all their traffic down the VPN tunnel, regardless of 
destination. If this option is enabled, the incoming GVC will be warned of this and will have the option to terminate 
the connection. 
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My VPN connection died when my system went to sleep/hibernated – any way to fix this? 
Yes, there is – just right-click on the connection in the GVC and select ‘Properties’. Check the box next to 
‘Automatically reconnect when waking from sleep or hibernation’. 
 
Does GVC integrate with Win32 login process? 
Current versions of GVC cannot integrate completely with the low-level login mechanisms in Windows, but versions 
2.0 and above of the GVC have the ability to launch login scripts after the connection has successfully 
authenticated and activated. To use this feature, right-click on the connection in the GVC and select ‘Properties’. 
Check the box next to ‘Execute logon script when connected’.  
 
The GVC icon is flashing blue – why? 
Traffic is flowing across the secured VPN connection to and from the SonicWALL. 
 
How do I find out what version of GVC I’m running? 
Go to the ‘Help’ menu in the GVC and select ‘About SonicWALL VPN Client…’. You will find the version and build 
number listed on this screen. 
 
Are there any diagnostic utilities in the client? 
Yes, there are several methods of troubleshooting -- the most important of these is the ‘Generate Report…’ option, 
which is found in the ‘Help’ menu of GVC. This will create a diagnostic report that captures the complete details of 
the GVC and of the system it’s installed on. If you are calling SonicWALL’s tech support to troubleshoot issues with 
the GVC, you will be asked to provide this diagnostic report. You can also use the real-time log viewer, the log 
capture to file option, and the connection status options to troubleshoot issues with connectivity. 
 
The real-time log is nice, but can I capture this info to a file? 
Yes, there are several ways to do this: 

1. You can export the real-time from the Log Viewer in text format by selecting ‘Save…’ from its ‘File’ menu. 
2. You can set the GVC to permanently write all real-time logs to a file by selecting ‘Options…’ from the 

GVC’s ‘View’ menu, clicking on the ‘Auto-Logging’ tab, and selecting the checkbox next to ‘Enable auto-
logging’. You will need to specify a path and filename to save all logging information to. 

3. The ‘Generate Report…’ option in the ‘Help’ menu of GVC also takes a snapshot of the real-time Log 
Viewer’s contents and appends it to the end of the report. 

 
Where do I get updated versions of the GVC? 
Customers with current service/software support contracts can obtain updated versions of the GVC from the 
MySonicWALL customer portal at https://www.mysonicwall.com. Updated firmware is also freely available to 
customers who have registered the SonicWALL device on MySonicWALL for the first 90 days. 
 
How many connections can I create? 
You can create an unlimited amount of connection entries in all versions of GVC. 
 
How many backup peer gateways can I define? 
You can define up to five backup peer gateways for each connection. 
 
What draft of NAT Traversal is used? 
All versions of GVC support draft 0.0 for NAT Traversal (NAT-T). An upcoming version will support 0.0 and 0.3. 
 
Can I shut off NAT-T? 
Yes – you can set NAT Traversal to ‘Automatic’, ‘Forced On’, or ‘Disabled’ on the GVC. This is on a per-connection 
basis, and is controlled via the ‘Peers’ tab for each connection profile (simply select the peer from the list and click 
on the ‘Edit…’ button to access the settings). By default, all connection profiles are set to ‘Automatic’, which means 
that if the SonicWALL is also set to use NAT-T, it will be negotiated during the connection process.  This is 
controlled by the ‘Advanced’ VPN settings on the SonicWALL device. 
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So, what exactly is NAT-T and why would I want to use it? 
Unfortunately, IKE/IPSec VPN connections cannot successfully negotiate if any device between the two endpoints 
performs network address translation (NAT) on the session, since IKE/IPSec notes the original endpoint source IP 
addresses as part of the setup. This is a common problem for software-based VPN clients that operate behind 
remote Firewall/NAT devices that are not set for ‘IPSec Passthru’, or simply are not capable of it.  In order to get 
around this problem, NAT-T encapsulates the traffic into UDP packets. This also helps with environments where 
any device between the two endpoints is set to block IPSec packets. NAT-T is on by default in the GVC and on all 
SonicWALL devices, and its use is strongly recommended. 
 
What is a virtual IP address/adapter? 
Use of the virtual adapter makes the GVC client appear as though they’re on internal LAN of SonicWALL by 
assigning it a unique IP address (and associated details) from the same subnet as the LAN of the SonicWALL.  
Three things must be activated for this to work: enable option in GroupVPN, enable DHCP over VPN with 
appropriate options, and optionally (if you’re not pointing off to another system), set up the internal DHCP server 
scope for LAN. 
 
Do I have to use the virtual adapter? 
No, you do not. While the virtual adapter is installed by default, use of the virtual adapter is defined entirely by the 
policy set up on the SonicWALL device’s ‘GroupVPN’ connector. It is not mandatory that incoming GVC 
connections use a virtual adapter, but doing so is recommended for most environments, since it eliminates many 
common problems associated with remote VPN connections, and eliminates potential asymmetric routing issues.  
 
Can I change the MAC address of the Virtual adapter? 
Yes, and if you need to, you can retain this when removing the GVC, for instances where you’d like to retain the 
MAC value when installing a new version. This feature was added in version 2.1.  
 
Can I set the GVC to start on launch? 
Yes, just add GVC to the Startup folder of the system it’s installed on, and set the connection profile to enable upon 
GVC launch. Please note that the GVC will actually start at user login time and not at system boot time.  
 
What crypto does GVC support? 
All versions of GVC support DES and 3DES encryption protocols, and with versions 2.0 and newer, AES is 
supported. For certificate-based IKE authentication, RSA signature and key algorithms are supported, but DSS is 
not currently supported. 
 
What hashing mechanisms does GVC support? 
All versions of GVC support MD5 and SHA-1 hashing mechanisms. 
 
What Diffie-Hellman mechanisms does GVC support? 
All versions of GVC support DH1, DH2, and DH5. 
 
Does GVC support Perfect Forward Secrecy (PFS)? 
Yes, all versions of GVC support PFS using DH1, DH2, and DH5. 
 
Can I view the downloaded VPN policy? 
Yes, but only when the connection is active and in an ‘enabled’ state. To see the active, negotiated security policy, 
right-click on the connection profile and select ‘Status’ (or click CTRL-T on it). This will pull up a menu that will list 
all details of the connection, including negotiated networks, traffic activity/counts, and virtual IP adapter information. 
To access the complete negotiated security parameters of the active connection, click on the ‘Details’ button on this 
screen. 
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The connection stopped and reports “Error” in the ‘Status’ section – any way for it to immediately 
reconnect when this happens? 
Yes -- to activate this feature, right-click on the connection in the GVC and select ‘Properties’. Check the box next 
to ‘Automatically reconnect when an error occurs’. 
 
Can I adjust the DPD settings in the GVC? 
Yes, but the settings are not global, and are done on a per-connection basis. To access the DPD settings for a 
specific connection, right-click on the connection in the GVC and select ‘Properties’. Go to the ‘Peers’ tab, select 
the peer you wish to adjust, and click on the ‘Edit…’ button. From this submenu, you can adjust the DPD settings 
timers, or deactivate them completely. 
 
Can I force the GVC to bind to a specific adapter? 
No, but it is possible to set the GVC to bind to only LAN adapters, or only to Dial-Up adapters. The settings are not 
global and are done on a per-connection basis. To access the interface binding settings for a specific connection, 
right-click on the connection in the GVC and select ‘Properties’. Go to the ‘Peers’ tab, select the peer you wish to 
adjust, and click on the ‘Edit…’ button. From this submenu, you can specify which what the GVC is bound to from 
the drop-down next to ‘Interface Selection’. By default, any connection profile created in GVC is automatically set to 
detect which adapter to use when the GVC is launched. 
 
How can I tell when the GVC is successfully connected? 
Once the connection profile is double-clicked, as the connection progresses it will move from ‘Disabled’ (inactive), 
to ‘Enabled’ (authenticated but traffic has not yet passed), to ‘Connected’ (traffic has successfully passed). 
Additionally, when the Global VPN Client is fully ‘Enabled’, a little green checkbox will appear to the left of the name 
of the policy. There is a fourth state, ‘Error’, which displays when the GVC cannot contact the SonicWALL, or loses 
contact with the SonicWALL and cannot resume the connection. 
 
The Log Viewer keeps noting same stuff – any way to stop it? 
As of GVC version 2.0, there is an ‘ignore redundant messages’ option in the GVC’s Log Viewer that can be used 
to stop this. 
 
The Log Viewer is not showing everything I want – why? 
You may have the ‘Show Filtered Messages’ option enabled in the GVC’s Log Viewer. If you’re attempting to debug 
a VPN connection and wish to see more details, you can activate additional ISAKMP logging in the Log Viewer. To 
do this, go to the ‘View’ menu of the GVC, select ‘Options…’, and check the box next to ‘Enable logging of all 
ISAKMP messages’.  
 
Can I sort the messages in the Log Viewer? 
Yes, just click on log column category to sort on that category. 
 
Can I use digital certs for phase one auth, instead of Simple Key or shared secret? 
Yes, as noted above, all versions of the GVC clients have a digital certificate import & management utility, but 
current versions of the GVC do not support the ability to create a keypair and certificate signing request (CSR). 
Keypairs, client certificates, and CA certificates must be created externally and loaded into the GVC using the 
provided utility.  CA certificates can be imported in PKCS#7 and DER formats, in Raw or PEM encoding. Client 
certificates and associated keypairs must be in PKCS#12 container format in order to be successfully imported into 
the GVC. 
 
Does the GVC support Main Mode? 
No, GVC and GroupVPN connector only use Aggressive Mode, and cannot be changed. 
 
Does the GVC interoperate with older SonicWALLs? 
If the device can run 6.4.2 or later, yes. GVC cannot interoperate with GEN1 devices since they cannot run 6.4.2. 
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Does the GVC interoperate with third-party VPN devices? 
No, it’s proprietary and can only work with SonicWALLs. This is similar to Cisco’s, Nortel’s and Check Point’s VPN 
clients, which are also proprietary and do not work with any manufacturer’s devices other than their own. 
 
Does GVC support NetBIOS broadcast encapsulation? 
No, it does not. Activating the NetBIOS options on the firewall side will have no effect on the GVC. If you are having 
issues with Microsoft Windows networking across GVC connections, it’s strongly recommended that you utilize the 
virtual adapter feature, and to make sure the virtual adapter obtains information from an internal DHCP scope that 
includes the proper WINS/DNS entries needed in order to resolve NetBIOS computer names on your network. If 
you’re not using the virtual adapter feature, you will need to statically encode these entries on the adapter, or use 
predefined HOSTS and LMHOSTS files on the system with all relevant resolver info. 
 
Where can I find help on setting up GVC-to-SonicWALL connections? 
SonicWALL maintains complete, step-by-step papers that can be used to set up both sides of the connection, for all 
shipping versions of firmware and software. The most current technotes can be found here: 

- link for Firmware 6.6 to GVC 
- link for SonicOS 2.0 Standard to GVC 
- link for SonicOS 2.0 Enhanced to GVC 
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